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Introduction

QlikTech was founded in 1993 as a software company in business intelligence (BI). Its PC-
based desktop tool was called QuikView. "Quik" stood for "Quality, Understanding, Interaction,
Knowledge." Initially the software was sold only in Sweden.

QlikView is the most flexible Business Intelligence platform for turning data into knowledge.
More than 24,000 organizations worldwide have enabled their users to easily consolidate,
search, and visually analyze all their data for unprecedented business insight using QlikView’s
simplicity.

QlikView create endless possibilities for making ad hoc queries without requiring tediously
defined structures and hierarchies, as.is typical in other data analysis tools. QlikView promotes
unrestricted analysis of application data, helping users make time-saving and accurate
decisions.

Main features and benefits of QlikView:

» Use of an in-memory data model

> Allows instant, in memory, manipulation of massive datasets

» Does not require high cost hardware

» Automated data integration and a graphical analytical environment attractive for
customers

» Fast and powerful visualization capabilities

» Ease of use - end users require almost no training

» Highly scalable - near instant response time on very huge data volumes

» Fast implementation - customers are live in less than one month, and most in a week

> Flexible - allows unlimited dimensions and measures and can be modified in seconds

» Integrated - all in one solution: dashboards, power analysis and simply reporting on a
single architecture

» Low cost - shorter implementations result in cost saving and fast return on in vestment

Risk free - available as a fully-functional free trial download
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This is the working model of QlikView behalf of this model QlikView works
Architecture Overview

Architecture Overview
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QLIKVIEW DESKTOP

When approaching a decision to implement and deploy QlikView, it's important to first
understand the roles of the various products that comprise a QlikView deployment.
QlikView deployments have three main infrastructure components:

> QlikView Developer,
> QlikView Server (QVS)
> QlikView Publisher.

QlikView Developer is a Windows-based desktop tool that is used by designers and developers
to create.
1) A data extract and transformation model and
2) To create the graphical user interface (presentation layer)

QlikView Server (QVS) handles the communication between clients and the QlikView
applications. It loads QlikView applications into memory and calculates and presents user
selections in real time.

QlikView Publisher loads data from different data sources (OLEDB/ODBC, XML, XLS), reduces
the QlikView application and distributes to a QVS because differently it's considered a best
practice to separate these two components on different servers.

BackEnd (Including Infrastructure source)

This is where QlikView source documents, created using the QlikView Developer, reside.
These source files contain either a) scripts within QVW files to extract data from the various
data sources (e.g. data warehouses, Excel files, SAP, Salesforce.com) or b) the actual binary
data extracts themselves within QVD files. The main QlikView product component that resides
on the Back End is the QlikView Publisher: the Publisher is responsible for data loads and
distribution. Within the Back End, the Windows file system is always in charge of authorization
(i.e. QlikView is not responsible for access privileges).

FrontEnd

The Front End is where end users interact with the documents and data that they are
authorized to see via the QlikView Server. It contains the QlikView user documents that have
been created via the QlikView Publisher on the back end. The file types seen on the FrontEnd
are QVW, .meta and .shared documents. All communication between the client and server
occurs here and is handled either via HTTPS (in the case of the AJAX client) or via the QlikView
proprietary QVP protocol (in the case of the plugin or Windows client). Within the Front End, the
QVS is responsible for client security.

Associative In Memory Technology’s

QlikView uses an associative in-memory technology to allow users to analyze and process
data very quickly. Unique entries are only stored once in-memory: everything else are pointers
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to the parent data. That's why QlikView is faster and stores more data in memory than
traditional cubes.

Memory and CPU sizing is very important for QlikView, end user experience is directly
connected to the hardware QlikView is running on. The main performance factors are data
model complexity,

amount of unique data, Ul design and concurrent users.

Building Data Model
A data model documents and organizes data, how it is stored and accessed, and the

relationships among different types of data. The model may be abstract or concrete. A data
model explicitly determines the structure of data.

These are the steps of creating data model using QlikView

Stepl For creating data model firstly install the QlikView then we can open the QlikView from
start-> click on QlikView11.

2L /) Paint 3 Fizzns
- @ chart2
VEE  Microsoft Office Word 2007 v [@ chartl
— [@ damo chart
, l Notepad 3 B a
S Demoll
[_'J VMware Workstation 2 [
- @ Demog
a
M V| C media player 4 [ Demo8
E 3
@ Dema?
ké'“' Windows Media Player 4 @ dermob
= (@ demod
[ 35 Microsoft Office Excel 2007 ’
(®) Qikview1s »

Step2: Then the Icon will responding to start QlikView
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k. With Qlikview Personal
" ted by other users, apart
Er Clikiiew files, you need
br & Mamed Client Access

Learn more about Qlikiiew Personal Edition
Enter a QlikWiew License Key

né) Learn QlikView

o

11.20,12018 5R3

Step3: QlikVi
new dashb

QlikView

Getting Started »

Recently Opened Documents
Favorites
Open in Server

Resources

Show Start Page When Launching QlikView

Create a new QlikViev

ow will o

*fou are running Clikview Personal Edition

QlikView Personal Edition H|
You are running Glikview Personal Editian.

GlikView Personal Edition is Free and For personal use only. With Qlikview Personal
Edition it is not possible to apen Qlikview dacuments created by other users, apart
From Qlikhiew supplied samples. IF you want to open other Qlikiew Files, you need
to obtain a Clikhiew User license, i.e, a valid license key or a Named Client Access
License on a Qlikview Server,

Learn mare about QlikYiew Personal Edition
Enter a Qlikiiew License Key

oo

Download Tutorial

11.20.12018 SR3

ton to create a

This window open for loading data from external sources like Excel only this will not allow to
take data from another data source.We can pass the Excel type of data format by going
through Browse option.
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! Step 1 - Select data source @ i

1. Select data source

To create a new QlikView document using this wizard, you first have to select an Excel file to use as your data source
When the data has been loaded into your document, the wizard will help you create your first chart.

Only for using Excel
sheets

@9 To select other data sources than Excel files, use the Edit Script dialog. The Edit Script dialog can be found
0' under the File menu

Show this wizard when creating new documents

< Back Mext > Finish Help

If you want to use data source different from Excel format like access or qvd data source
going through this process->Click on “Cancel”, so that we can save the document with the
blank datamodel and dashboard.

Step4: To save the created document, click on the “Save” icon as shown below.
Save the document anywhere on the local machine and give the name of the application as you
wants to create.

L = Save As @
- . S |
\.J)\../) Il! Desktop » - ‘ +4 |I Search Desktop 2

: Organize » Mew falder ;,‘:: - 9

1 E Videos o= Lo T

[ Libraries

= || System Folder
+& Homegroup -
Homegroup I
‘M Computer ‘ System Folder
&, Window 2007 (C Provide the File name
Office (It) | DataStage By VK - -
e a
. Software (E) 53) System Folder as | gave QIIkVIeW
€ Network { (riomputer
V=SS System Folder
& BISP-6 )
M Kp-pC i e ek i
File name: hd
Save as type: | QlikView Files (*.qww) - |
= Hide Folders l Save ] | Cancel ‘

Step 5 For loading the tables into the QlikView datamodel, we need to open the Script editor
(“Edit Script”) By going through the option available in File available in the menu as shown
below.
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@ QlikView 64 Personal Edition - [QV2] =N e (=

File §Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help -8 X
i J New CrlsN - 2 | 5% | € | @) ;.@?E i md [0 Clear ~ | (@ Back &) Forward | (5 Lock g
j| 2y Oen.. 0 ) (S @) () (@) ) @) ) A ) B bk ad e o 5 e 12
7 5 Openin Server... Ctrl+Shift+0
Open URL...
Open FTP...
Close
Favorites 3
sl Save Ctrl+S

Save As... F12

Mail as Attachment...

Print Sheet...

Source Control »

Export 3

Import 3
j_«? Edit Script... Ctrl+E :

=) Reload Ctrl+R

=] Partial Reload Ctrl+Shift+R

Reduce Data »

Once opened, the Script Editor window will appear with some default set statements. These
Set statements will tell QlikView what should be the default number settings to be followed
throughout its use in the document.

f File Edit Inset Tab Tools Help
) Reload #Debug | i | 4 3 % | 4O (3 & (2 Tabs Main =128 2

Main

SET ThousandSep="',';

SET DecimalSep='."';

SET MoneyThousandSep="',"

SET MoneyDecimalSep='."';

SET MoneyFormat='$#,##0.00; (5%, #%#0.00) '

SET TimeFormat='h:mm:ss TT';

SET DateFormat='DD-MM-YY';

SET TimestampFormat="'DD-MM-YY h:mm:ss[.fff] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May; Jun;Jul;Aug; Sep;Oct;Nov;Dec' ;
SET DayNames='Mon; Tue;Wed; Thu;Fri;Sat;Sun';

Data | Funstions | Yariahles | Setlings

Database Data from Files
OLE DB - Relative Paths Table Files.
e
Force 32 Bit Qlik¥ier Fie.
\uéeb Files
Field Data

[ ok J[ cancel ][ Hep |

Step 6 Now the data records as in the form of access,qvd or excel sheet this covers the
procedure extract which is the fundamental procedure of datawarehousing by connect option
we import the access file in which records are saved.Select the Database connection type from
Data tab in the Edit Script window as shown below :

www.bispsolutions.com www.bisptrainigs.com www.hyperionguru.com Page 9



http://www.bisptrainigs.com/
http://www.bispsolutions.com/

an:w :'.'c.m: Sl

Datshate Dhadi from ke
OLE b8 ¥ Relaivg Pths | TobleFiln
s FTP
o Foioe I Bi Salecd G ViewiFle
Wb Fie:
Fudd Dl

UK Lancel Heb

Then the popup window DatalLink Properties will appear on which number of OLE DB Providers
are displayed through which we will select the Microsoft Jet4.0 OLEDB Provider then for
connecting the data base we will going through the next button.

EJ  Data Link Properties @

Provider |Connedion | Advanced | Al |

Select the data you want to connect to:

s

QLE DB Providenis

{0 OLE DB Provider
Microsoft Office 12.0 Access Database Engine OLE DE Pro
Microsoft OLE DB Provider for Analysis Services 9.0
Microsoft OLE DB Provider For Data Mining Services
Microsoft OLE DB Provider for Indexing Service
Microgoft OLE DB Provider for CDBC Drivers
Microgoft OLE DB Provider for OLAP Services 8.0
Microsoft OQLE DB Provider for Oracle
Microgoft OLE DB Provider for Search
Microgoft OLE DB Pravider for SGL Server
Microsoft OLE DB Simple Provider

m

MSDataShape
OLE DB Provider for Microsoft Directory Services -
1| i 3
[ ok || Cancel || Hep |

After clicking the Next option the popup window will appear that will ask you for the location of
the particular file you want to import in your application.

Browse the file or MS Access datadase which we want to import into QlikView.
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£ | Data Link Properties

Connection | Advanced | &l

Specify the following to connect to Access data:

1. Select or enter a databasze name:

2. Enter information to log on to the database:

User name: Admin

Test Connection

Blank password [~ Allow saving password

oK || Cancel ||

Hep |

We will select the file “Salesmanl.mdb” which is already available in local machine.Select the
location of the particular then ->click on open button this will import salesmanl.mdb in your

application.

=} Select Access Database

@Qqﬂ v QlikView » files »

4 Downloads
=] Google Drive

4l Libraries
3 Documents
rJ“- Music
le=| Pictures

B Videos

*@ Homegroup

Organize » Mew folder

- Favorites Name
Bl Desktop . CSVs
1= Recent Places , QVDs

- | 3 l Search files pe |
=~ O @
Date modified Type
20-5ep-13 9:42 AM  File folder
20-5ep-133:50 AM  File folder
20-5ep-13 9:40 AM  Microsoft

m

121 Dimension Tables
2] salesmant

16-5ep-13 10:04 AM I‘v'1icrc:5c:f|

- 4|

I

3

File name:lsalesmanl

- I ’Microsof't Access Databases ("1 v]

o1

Cancel ]

Here the window will appear on which in the 1st option the location of the data base shown
which is going to import and in 2nd option by default user name given as Admin and password
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you can give as per your choice although this field is not essential.

Connection | Advanced | Al

&I Data Link Properties @

Specify the following to connect to Access data:

1. Select or enter a database name:

2. Enter information to log on to the database:

Uzer name: Admin

CiUgers'as\Deslktop \QlikView files'salesman 1.mdb g

Blank password [ Allow saving password

e oo

OK || Cancel || Heb

|

then click on the->test connection. A popup window appear with message connection is

succeeded:

Connection | Advanced | All

£F | Data Link Properties [=]

Specify the following to connect to Access data:
1. Select or enter a database name:

ClUsershashDesktopQlik\View files'salesman 1.mdb E]

2. Enter information to log on to the database:

User name: Admin

Micresoft Data Link [23m]

o ..\._
[o_l Test connection succeeded.
-

o

Test Connection

[ ok |[ canced |[ Hep

J

Then click->o0k

Now that we have successfully connected to the Access database, we can see the connection

details in the Script Editor window.
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@ Edit Seript [C:\Users\as\Desktop\QlikView Demo.qvw]
i File Edit Inset Tab Tools Help
"} Reload [ Debug | [ | 4 5 ] 4D [ &1 5 Tabs Main

3.
M-

[E=SE=E==)

tain

SET
SET
SET
SET
SET
SET
SET
SET
SET
SET

ThousandSep=",";
DecimalSep='."';
MoneyThousandSep=",";

MoneyDecimalSep='.";

MoneyFormat="'5#,##0.00; (5%, ##0.00) ';

TimeFormat="h:mm:ss TT';

DateFormat='DD-MM-YY';

TimestampFormat='DD-MM-YY h:mm:ss[.£££f] TT';
MonthNames="Jan;Feb;Mar;Apr;May;Jun;Jul;Aug; Sep;0ct;Nov;Dec';
DayNames='Mon; Tue;Wed;Thu;Fri;sat;Sun';

<[ n ]

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\L

Data | Furctions | Warisbles | Settings

Database Diata from Files
OLEDE - [7] Relative Paths Table Files.
Buere
Force 32 Bit Dlikview File

“W/eb Files,
Field Data.

13

Ele Sl e ]

QLEDE CONNECTI2 LOLEDB. 4.0 Use

T0 [Provider=Microsoft

|

Step 7: Next we have to Load the fields of the MS Access table in the Datamodel. Click on

“Select” button as shown below :

i File Edit Inset Tab Tools Help

[} Reload [ Debug | ol & | 4 53 (3| £ [ 51 [ 5 Tabs Main =

b air

SET
SET
SET
SET
SET
SET
SET
SET
SET
SET

Thousands
DecimalsS
MoneyTho
MoneyDec
Money¥For
TimeForma
DateForma

ep="'."';

SH#,#H#0.007 (S#,##0.00) ' ¢
h:mm:ss TT';

='DD-MM-¥Y" ;
TimestampFormat="DD-MM—YY h:mm:ss[.£f£ff] TT':

MonthName.
DayNames="'Mon; Tue;Wed; Thu;Fri;Sat;Sun';

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User

='Jan;Feb;Mar;Rpr;May;Jun;Jul;2ug; Sep;Oct;Nov;Dec';

ID=Admin;Data Source=C:“Usersias\C

Data | Funetions | Variables | Setiings |
Database D ata from Files
OLE DB - [] Relative Paths Table Files

[ Uss FTP

Qlikiews File...
Wb Files...
Field Data...

T | O | ——

Click Select Statement window will appear, which display all the tables (with fields), views,

synonyms & aliases available in the database.
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@ Create Select Statement (== o]

Bl Semes Provider=Microsoft.Jet OLEDB.4.0;User ID=Admin;Data Source=C\U H .
ere the fields
Dwner are snown
available in
Database Tables Fields Teut Order - . .. .
Crae
Yiews Distributer Id /
1D
[ Synonyms S alesman “
[] System Tables S alesman 1D
[ &liases

[] Show |con for Key Fields

Soript ‘ Table | Colurnns I Freview | Elobs |

SQL SELECT * @ Column

FROM salss: ) Row
() Structured

[] Preceding Load

Add

Fl »

[ oK ][ Cancel ][ Help ]

By default, the “*” is selected and the default SQL script is displayed in the Script tab, as
shown above.

We can always have the privilege to select individual fields as required. And the SQL script is
automatically generated by QlikView in the Script tab.

g
i

1 Create Select Statement EI

Data Source Provider=Microsoft. Jet. OLEDB.4.0;User ID=Admin;Data Source=C\U

| Databasze Tables Fields Text Order -
Tables
| [ views
| [C] Synorgms
| [7] Systern T ables
[C] Aliases [ Show lcon for Key Fields
Script |Tab|e I Columnsl Presigm I Blobs |
SQL SELECT ‘Distributor Id‘, 4| @ Colurn
ID, ) Row
Salesman, () Structured
Salesman ID [T Preceding Load
FROM sales;
j Add
, P
] Cahcel ] l Help l

Click on OK, to proceed further.
Now, in the below “Edit Script” window we can see that we have 2 things :

1) Connection link to the datasource
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2) Selected Fields to be loaded into QlikView datamodel.

@ Edit Script [C:\Users\as\Desktop\QlikView Dema.quw] =g =
i File Edit Inset Tab Tools Help
U} Reload [#&Debug | [ & | & 9 0% ] S0 [ & 2 Tabs Main P ==

Main

SET

##0.00; (S#,%%0.00) '

h:mm:ss TT';

SET DateFermat='"DD-MM-YY';

SET TimestampFormat='DD-MM-Y¥ h:mm:ss[.f££] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun; Jul;Aug;Sep;Oct;Nov;Dec';
SET DayNames='Mon; Tue;Wed; Thu;Fri;Sat;Sun';

OLEDB CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\L
SQL SELECT “Distributer Id",

ID,

Salesman,

*Salesman ID®
FROM sales;

Database Data from Files

OLE DB - Connect. [7] Relative Paths Table Files.
Force 32 Bit Blus=F1R QlkView File
Wb Fles.
Field Data..
(o J[ cancat | _Her |
talk — (] 5 e me um qp  1O3TAM
= IQ [ = ”-l I= “ D “| @ H B0 s |

Step 8 :

Now its time to load this data into QlikView. Click on “Reload” button as shown below :

@ Edit Seript [C:\Usersh\as\Desktop\ QlikView Demo.qvw] \E/\E/E
Lfile_Edit Inset Tab Tools Help

Debug | | | 4 3 4]0 1] <] 2 Tabs Mein pja

J. Reload

1

Once loaded, we can see all the fields are now available in QlikView datamodel.

Select all fields and Add all fields
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Sheet Properties [Main] / @

| General | Fields | Objects | Security | Triggersl
Awvailable Fields

Fields Displayed in Listhoes

Distributor Id
1D
Add >
watidia) || oo
Add Al Salesman 1D
—

< Remove

Show Fields from Table
© Al Tables

[7] Show System Fields

The field which are marked are selected fields which will display on the dashboard Click on
->Apply than->“0OK".

Now we can see that all the fields are now available as list boxes in QlikView dashboard.

Here the fields SalesmanlD,Distributorld and Salesman fields available which shows the data.
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i File Edit Wiew Selections Layout Settings Bookmarks Reports Tools Object Window Help

LS ) )20 o) O e ) ) e 57 a8 K Cear - | @ Back

)Foward | ) Lock f Unlock [

L A (B () () (B) (o) (5, ) (B[, 5), ), ) (O ()i o e

B S

These are the fields
which are selected in
previous stage

-5 X

PRy

Main

Distributor Id

oo = D

Salesman
abhi
ajay
akash
il
ankit
anuj

Salesman ID

101
102
103
104
105
106

For Help, press F1

Step 9 :
Joining more tables of different format.

17-09-13 11:41:15 AM*

Open Script Editor (Ctrl + E), Click on “Table Files” under Data tab.

www.bispsolutions.com www.bisptrainigs.com
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: File Edit Inset Tab Tools Help
) Reload [ Debug | 4 = | 4 3 5] 6O (3¢ |2 Tabs Main Eof ===

tain

SET ThousandSep=",'; 3
SET DecimalSep='."';

SET MeoneyThousandSep="',"';

SET MoneyDecimalSep='.";

SET MoneyFormat="5#,##0.00; (5#,#%#0.00) ';

SET TimeFormat='h:mm:ss TT';

SET DateFormat='DD-MM-YY';

SET TimestampFormat='DD-MM-YY h:mm:ss[.f££f] TT';

SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;Rug;Sep;Oct;Nov;Dec';

SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';

OLEDE CONNECT32 TO [Provider=Microsoft.Jet.OLEDB.4.0;User ID=Admin;Data Source=C:\Users\as\L
SQL SELECT ‘Distributor Id",

ID,

Salesman,

*Salesman ID"
FROM sales;

[l 1 ]

Data Funclinnsl\f’afiah\as Settings

Database Data from Files
OLE DE [] Relative Paths Table Files
—
Force 32Bi [10se FTP Qs il

web Files...
Field Data...

akK H Cancel ” Help ]

Select the “Transaction Tablel.xIs” -> Open

@ Open Local Files =23
Look in: | Ml Desktop - @ ? -4 '
I 2,63 KB 3
!
g = GHR_Model
Recent Places Text Document
857 bytes
B kkkk
Text Document
62 bytes

., modified ghr script
Text Document
Libraries 3.64 KB

P L Teradata _13-5ep-2013
Firefox HTML Document

‘;"“w—
Computer Lo ks |
I Transaction Tablel <& £
@ =3 Microsoft Office Excel 97-20... - i |
al | 175k =
Metwork
File name: Transaction Table1 -
Files of type: [NI Table Filzs v] Cancel

“File Wizard : Type” pop-up window will open. The File has been automatically identified by
QlikView as “.xIs” and all the available fields in the sheet are previewed / displayed.
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2 File Wizard : Type @
File Type Tables Header Size
_) Delimited Sheet1s - MNone - 0
" Fixed Record Labels
_) Dif Embedded Labels -
@) Excel (xls)
_) Excel (usx) customer ID = I]]ajr x krﬂgs margin *x II.is‘t i
_) Html 1 Monday 2% 50
) Qwd 2 Tuesday 3% 40
wml 2l 30
) Qux 4 70
5 80
& 85
4 »
I < Back I I MNext = J I Finish I [ Cancel ] I Help

Click on “Finish”.

Now, we can see the load statement is created with all the fields from the excel file in the script
editor window.

= x:nr[:ncnpt[u\users\as\usxtop\quxwewuemo.qvw"] = (=P | ||
i File Edit Inset Tab Tools Help

} Reload [ Debug | + & | A | 0 [ i1 [ Tabs Main (=8 =2

bdain
*Salesman ID® o

FROM sales;

LOAD [customer ID],
Day,
[Gross margin],
[List price]l,
month,
[product Id],
sales,
[Salesman ID],
[Serial no.],
[Tran Id],
year
FROM
[C:\Users\as\Desktop\Transaction Tablel.xls]
(biff, embedded labels, table is [Sheetl$]):

m

Step 10 :

In this step we will see the Generation of keys and relation between them and will join these 2
tables loaded from 2 different sources.

Database “salesmanl” and table “transactiontablel” contains one field in common.
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1) If one of the field in both tables are same then QlikView automatically generates the relation

between both tables and will merge the keys.

Sheet Properties [Main]

| General | Fields |Object5 I Security I Triggers|

==

Available Fields

:  customer D

Day

(Gross margin
List price
manth
product Id
sales

Serial no.
Tran Id

year

Add >

< Remaove

Show Fields from Table
Q@ Al Tables

[ Show System Fields

Fields Displayed in Listboxes

Distributor Id
D
Salesman
# Salesman 1D

[ OK H Cancel ] Ppply

Help

Here the
salesman
id field as
well as
values are
same so
the
relation
automatic
ally

NAnAratAaAd

From here you can select those keys which you wants to display in listbox by double clicking

the key.

Select more fields to the right, to be displayed in dashboard.

Sheet Properties [Main]

| General | Fields |Objed5 | Security | Triggers|

Available Fields

Fields Displayed in Listboxes

After->apply and->ok the new field will also add in the dashboard

www.bispsolutions.com

customer 1D Day
(Gross margin Add > Distributor Id
List price D
month -Md Al s> sales
product Id - Salesman

<Remove | | Salesman ID
Tran Id year

Show Fields from Table

@ All Tables -
[ Show System Fields
[ ok |[ cance ][ #pply

www.bisptrainigs.com
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File Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help -8 X

RRr=3 = R NNE e N |\}_-’|:2|‘4’Hu|ﬁ|.ﬂ|t_J);.§?H§3€jj[NC|earv\ {8 Back 1),-50.'...'—.':.|ﬁLockJ'UnlockH
i 2 P
Main
Distributor Id £
1
z
3
4 Salesman ID A
5 101
Day £ . 102
Monday 103
Tuesday 104
105
sales s 108
Salesman 2 3000
i 5000
ajay 10000
Lach 15000
:mits 25000 customer ID P
ankit 40000 ;
anuj 3
4
year F 5
001 6
200z
2003
2004
2005
200
The new fields are Day,Year,CustomerlD,Sales selected from Transaction Tablel.............

In the above table, we can see only one “Distributor ID” column, as it the key between the 2
tables.

Now we look at the Table Viewer in QlikView to see how the 2 tables are joined and
represented.

To navigate to Table Viewer, Click on below shown icon or Ctrl + T

B T Sl e e I TE e
i File Edit View Selections Layout Settings Bockmarks Reports Tools Ohbject Window Help R
RN, I&L’Ii’l'ﬁ’ﬂulfrlﬁlwvs'?ﬂf'lfvlé.-se-:v ——— ock

e 2 4 (B)E) 6 () () (=) (v) () () 5@ ) (@) 5] (6] i O - £5#AE20H

The two tables automatically containing the join due to the same key field which is “Salesman
ID"
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@ CAUsers\as\Desktop\QlikView Deme.qvw = @

‘g Export Image *EzExport Structure (< Print -3 Copy Image | -£3Aute-Layout | 100% = | Internal Table View

SHEetl )
Salesra,., »
custome. ..
Day

Gross m...
Listprice |z
manth
product Id
sales

Serial no.
Tran Id -

sdlEs)

~——a| Salesran 1D
Distributor Id
1D
Salesrman

0K | [ Concel | [ Heb |

|L°2H ~ ][R

S ACIE R ] ER

2) We now have another scenario, in which the field format / name is little bit different but
contains the value same.In this case join will not be automatically created as the field names
are not matching. But we have to establish join between those fields.To sort this out, we will
now import one more database / table customer table.xIxs) into QlikView datamodel to see
how we can fix this.Below are the fields of the table “customer table.xIxs”

For this we will connect another table named as customer table.xlIxs follow this procedure
->click on table files->browse the location of the table customer table.xIxs

Data | Functions | Yariables | Settings

Databaze Drata from Files

OLE DE - Felative Paths Table Files...
—————— Use FTFP e =
V| Force 32 Bit Coie e | QlikMigw File...
| webFiles..
| FieldData..

QK || Cancel || Help
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'@ Edit Script [C:\Users\as\Desktop\QlikView Demo.qvw?] =]l | =]
p P q

File Edit Inset Tab Tools Help

)} Reload |3 Debug | | o | A | 0 [ /1 [ Tabs Main - a8 =

tain
“Salesman ID" a0
FROM sales;
! File Wizard : Type @
LOAD [customer File Type Tables Header Size
?ay, _) Delimited Sheetl - MNone -
[Gross ma)
[List pri _) Fixed Record ik
monch, | o EETETT——
[product
= ") Excel {xds)
sales, T
[Salesman| @ Excel (xlsx) Customer ID X |customer X |ad.dres= X |cit.g x |=ip x ‘cuum
[serial nl  bitml 1 amit abc def ind
[Tran Id] e z anuj paor st ind
vi
year 3 ankit bus stand |bpl ind 3
FROM ] 4 akash railway  |bpl ind
[C: \Users\asip O Qux s abhi ronawala [mumbai ind
(biff mbedd
1 (=) =] =
’ & ajay mahu indore ind
€ e il 3
< 2
Data | Functions | Variables | Setting
Database I < Back J { Mext > ] I Finish I { Cancel ] I Help
OLE DB -
—_— [ [Use FTP
Farce 32 Bit Select,.. Qikjewi Gl
wieb Files...
Field Data...

l ok H Cancel ” Help J

(Glr=]7] @] LTI

5 A RER)

We will now directly import this into the datamodel.

> Click Finish.

> Click Reload.

Now looking at the Sheet Properties window which pops-up automatically after the reload is
done.

Here the two fields are shown

First one is “customer ID” from transactiontablel.xls

Another one is “Customer ID” from customertable.xIxs.

The difference is the “c” in both the fields / columns. “c” in one table exsist in uppercase or in
another exists in lowercase. This mean key is not allowed / possible.

QlikView Rule_: To have join between a common field in 2 tables, the column names
should be similar, as QlikView is case-sensitive.
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Shest Froperies [Main] ==
Genersl | Folde | Dibgects | Seouty | Tapges
Sl b Fomidn Fomidn Dangdorped r1 Ledthome s
adciress Dy
oty TP Dustrbaor id

ey

ST Add Al 3 mhed
oustome 1D Splesran
o 1L # Salewman 1D

= Pz

Cierzan e

rrezntt
proschuct i
Seiril i
Temn b

G

S Feabshy femen Tabie
@ Al Tobies -

o System Feslds

L oK Carcel tieg

Now when we see in the Table Viewer, there isn’t any join created between the 2 tables, just
because of the “c” is in different case in both the column names.

g ExportImage & Export Structure = Print |3 Copy Image | =25 Auto-Layout | 100% = | Internal Table View

SHEEL])
sheetd’)

Customer ID
Salesma... a fe=— customer
custome.., address
Day City
Gross m... zip
Listprice |z 4| cuonty
ot

sales)

product Id T ——a| Salesman ID
sales Digtributor 1d
Serial no, i}

Tran Id - Salesman

[ akK ][ Cancel ]l Help ]

so the solution is that we have to do editing in scripting section where all the three database's
script are already loaded.

With the "as" keyword we will establish the relation and show that both fields are same and
will rename the column name in “Customer table.xIxs” load statement in Script Editor.

Load [customer ID] as [Customer ID]
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i File Edit Inset Tab Tools Help

L Reload [#Debug | (=l <8 | 4 o @] 4O [3 <0 [0 Tabs Main - =

=
M ain

[2alesman ID],

[Sserial no.1,

[Tran Id].,

yvear
FROM
[C:\Usershas\Desktop\Transaction Tabklel.xls]
(biff, embedded labkels, takle is [Sheetl$1);

LOAD |{Customer ID]las [customer ID}| ,l
customer,
address,
city,
zip,
cuontry

FROM

[C:\Usersh\as\Desktop\customer table.xlsx]
(ooxml, embedded labels, table is Sheetl);

m

« T

Now we can see the two keys start containing the relation ship between three tables.

i i — il & L W — 1 e i
Sheet Properties [Wain] =
Formilable Fusida Fesds Dinplarpad in Listhoooss o
st pom— i
= & oustormesr 1D
Fackdl

ouoniny S Custrbatior id

Dy S Al 5 I

(Groes manpn 5 | taled

List e ¢ Resmave Selesman

manthy 8 & Salesman I

product i Y

Sl

Tran ki

]

In table view we can see the join between these three tables.

@ C:\Users\as\Desktop\ char2.qvw

= e e
g Export Image *x Export Structure (=4 Print 53 Copy Image | 5 Auto-Layout | 100% | Internal Table View
Sales,
Salestman ID
Distributor 1d
D
Salestnan
[ ok ][ cemcel | [ He
- ) 2 falk == || e € [ © 439 PM
Bl cle = @|Jl=]di]e] _omme ST
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Step 11 :

Now we will see how to add new list boxes / fields in the QlikView dashboard as and when

required.

@ QlikView x64 Personal Edition - [C\Usershas Desktoph\ Qudemno. gvw®]

! File Edit View Selections

FRN=RoN" =T SE R

Layout Settings

Bookmarks  Reports  Tools

Object  Window Help
O B sl i | [ @) 52 E im8 [} Clear - | (@ Back (@) Forward | () Lock

=N B ==

-8 X

Salesman ID

This will open the popup window, from where we can

drop down.

| Mew List Box

List Box...

" Properties...
43 Select Fields...
| New Sheet Object v |2
Copy Sheet =
g e aste Shee ct as Lin H
104 aash Print... al

General | Expressions ISurl I Presentation I Numberl Fort I Layout ICaptianl

=

[ Show as TreeView

Title Object ID
Field Search
I address - Include Excluded Values in Search
<use default> -
Use as Title
Default Search Mode
And mode [C] Show Frequency <uge default> -
[ 5how Atematives In Percent
[ Hide Bxcluded Mare Search Settings
[71 Read Only
Always One Selected Value Print
[T]Ovemide Locked Fisld

[ Print All Values
Layout Dependent Print

We will now select the “product Id” field by scrolling the option field.

www.bispsolutions.com

ok || canca ||

Help

www.bisptrainigs.com

Statistics Box...
Multi Box...
Table Box...
Chart...

www.hyperionguru.com

select the desired field from the “Field”
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Mew List Box @‘

General | Expressions ISort | Presentation I Numberl Fant I Layout I [‘aption|
Title Object ID

&

Field Search

product I1d - Include Excluded Values in Search
address v

city
cuontry
customer -
E 47 customer ID
Day -
O Distributor Id s
Gross margin
C ID
List price
morth
O product Id
[ sales
Salesman it Print
4% Salesman 1D
Serial no.
Tran Id
year
zip
<Expression>

[ ok [ cancd |[ Hep

@ QlikView x64 Personal Edition - [C\Users\as\Desktop' Qvdemo2. quw®] =] e X
! File Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help -8 X
BN = lgld|-£-.él|") m|p|z|‘{ﬂg|i}|f|9)k§?l§3€§[KIClearv|-§-‘)Baclr.-5>)Fcrv\ua|'c||ﬁLockJ‘Unlock!

;-II

customer
abhi

alay

akash

arnik

ankit

anuj

product Id ~
512 D

Distrib...

comewme D
o
&
=1
womuomae D

year &
2001 2002 2003 2004 2005 2006 address »

Salesman »r

sales ~ abhi

ahe 3n0n aiay

bus stand s000 akash

mahu 10000 annit

par 15000 ankit

ralvvaty 35000 anuj

ronawala 40000

customer ID

oo e wm e D

For Help, press F1 17-09-1311:58:00 AM*  D: 6/6 F:6/6

Enel e =S lEl:

Here the fields customer,Distributionld,Product Id,Salesmen,customer ID,address,year,sales are
the fields added in the application
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Creating a Chart

Creating chart using table

in which the graph can be implemented between two values / fields,

one can be taken in the X-axis and another one on the Y-axis.

Before creating the chart,

by

we will do some formatting and clean up of the fields/ list boxes
available on the dashboard.We can change the view of field / list box from horizontal to vertical

Ignoring or de-selecting the option “single column”.

List Box Properties [Distributor Id]

|Geneml | Expressions ISort | Presentation | Number | Fort | Layout | Cap‘tion|

Image Options
Representation
Text

Image Formatting
Fill with Aspect
Hide Text When Image Missing
Selection Style Overide
<User Default=

[ Single Column

Suppress Horzontal Scroll Ba

[ Fixed Mumber of Columns
Order by Column

[] Cell Borders

Highlight Search Substring

Alignment

Left

Center
@ -

Right
Text

Numbers

Muttiine Settings
[ Wrap Cell Text

Height |2 Lines

(. (N T

Now we can see how the values in the “Sales” list box are transposed from

Vertical to Horizontal view.

sales

3000 5000 10000

15000 35000 40000

£

www.bispsolutions.com

www.bisptrainigs.com www.hyperionguru.com



http://www.bisptrainigs.com/
http://www.bispsolutions.com/

For creating the chart :

rightclick on screen->New Sheet Object->Chart

LTI

ﬁ Properties...
gM Select Fields... B ListBox.
New Sheet Object s !Iz_] Statistics Box..
Copy Sheet El Multi Box...
W Dot E| Table Box..
J=aqy Fase >
Pacte S} A il Chart...
. _=r_l Input Box...
Print... 3 :
¥ Coovl to Clinboard V|| Current Selections Box...
54| Copylmageto Clipboar 3
Py ; = Button..
Export Image to File E :
Al Text Object...
! Pl -=1| Line/Arrow Object...
Femowe &) Slider/Calendar Object...
¥ E
5 |@¥l Bookmark Object..
& |la] Search Object..
£l Container...

@I Custormn Object...

System Table

Select the type of chart you want to use Requirement : “Average Sales Vs. Year “ in bar chart
format

(IR R 1T T I I} ] e B e R B L S
General @
Window Title Chbject 1D
Show Title in Chart
@
[ Detached Print Seftings...
[] Read Only
Calculation Condition
Chart Type Fast Type Change
Allowed Types 5
o Wﬁ (_“- .-I = [ BarChart -
I I E 3 @ ll. = [ Line Chart
: [~ Combo Chart £
£ [~ Scatter Chart B

e 120 28] @) T FE o

[~ Straight Table -
C h a rt Prefemed Icon Posttion
Reference Mode: © In Chant
[F{esei User Docking] [ Ermor Messages... Dimmed - @) In Caption
< Back MNead > Finish Cancel ] [ Help
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Choose the fields (Year) with which we have to plot a chart include them by

“Add” option

umE

— R - I

Dimensions

Ayailable Fields Groups

address
city
cuortry
customer
4% customer 1D
Day
Distributor 1d
Gross margin
1]
List price
manth
product Id
sales
Salesman
4% Salesman 1D
Sernal no.
Tran Id

] Show System Fields

Show Fields from Table
Al Tables

[ Animate... ] [

Trells... |

Used Dimensions

Add =
< Remowve

Fromote

Demote

[ Add Calculated Dimension...

J [

Settings for Selected Dimension
[~ Enable Conditional

] Suppress When Walue Is Mull
[] Show All Values
Show Legend

[#] Label
()
Commert
- (5
Page Breaks
Mo Ereaks
[ <Back |[ Net> | [ Fmish | [ Cancel Help

By clicking next the popup window will appear in which you can prefer which type of Expression
you want to perform with data.

&1 Edit Expression

! File Edit Sef

address

city

Expression OF

cuankry

customer

& cuztomer 1D
Dray
Digtributor 1d
Gross margin

D

List price
month

praduct 1d i
4

Figlds | Function .‘.Salesman
4 Salezman ID

. Serial no.
Agagregation Tran Id
year
Table Zip
Field address E]

]

P

[ Show System Fields

Diztinct

0k Cancel ] [ Help

We can create an expression from a varied choices of available functions.
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&1 Edit Expression
! File Edit Settings Help

Expression 0K

4

Fields | Functions | Yariables | Images|

[o]-O/u]

Agaregation

L.J 0

i

Table

Fractile
Kurtozis

Lazt Sting
[LET

Min

Mizzing count
Mode Value
Hull count
MHumeric count
Only vwalue
Skewness
Std dev

Sum

Text count
Total count

Diztinct

e

Field

QK Cancel ] [ Help

17-09-13 11:58:00 AM™  D:€

By clicking “Paste” button the expression will be copied in the blank area.The expression we

have selected is the “Avg (sales)”
I 11—

[ @ EditEpresion o=
! File Edit Seftings Help
Expression 0K,
Avg (sales) M
2
] [
Figlds | Functions Variablesl Images|
Aggregation Average -~ |0 s
Table @ Al Tables » [ Show System Fields
Field sales ~ || Distinct
Paste <
Ok ] [ Cancel ] [ Help
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->Click “OK”

[ Add ] [ Promote ] [ Group ]
[ Delete ] [ Demote ] [ Ungroup ]

() Accumulate 10 % Steps Back
Trendlines

[ Average « | []Show Equation
Linear Ijl []1Show R2

Polymomial of 2nd d

[¥] Enable [ Conditional

Label
=use expression= E]
Definition
Avg (sales) B
Comment
Relative
Invisible:
Dizplay Options Total Mode
Bar Mo Totals
[] Symbaol Autto - (@) Expression Total
of
[] Stock
[] Box Plot

["] Has Emor Bars 2= Lo

=1
[ Values on Data Paints Ot =1
[ Test on #oas [¥#] Expressions as Legend

Text as Popup

->Click on “Finish”.

The chart is c which sh

Avg (sales)
Avqg (sales)
40,000
20,000
20,000
10,000 .
, B . m
2001 2002 2003 2004 20045 20086
wear
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